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INTRODUCTION

The Pacific Coastal Resources Atlas (PCRA) for British Columbia, Canada, was developed in
response to the expressed need for creating easy access to information that can be used by
anyone with an interest in Coastal Marine Resources Planning. The goal of the PCRA is to
provide Government agencies, Regional and Community Governments and NGO’s access to the
best available coastal resources datasets; an additional benefit is that in this way, all interest
groups will be “working from the same page” of information.
To date, both freshwater and coastal resources fishery information has been housed in a huge
variety of data warehouses; some of these are digital, some are available in hardcopy form only,
and much of our coastal resources knowledge still remains in the form of unwritten Local and
Traditional Ecological Knowledge (LEK and TEK). The PCRA brings together information on
the spatial distribution of coastal marine resource and resource use from these various sources in
a format that allows the user to easily access and overlay relevant data layers. Although the
individual databases and GIS layers may reside on different computers in a range of agency data
warehouses, the PCRA system is designed to make all of the information accessible to
information users and providers at one specific location through the Internet.
The Pacific Coastal Resources Atlas is available through the Community Mapping Network
(CMN). The Community Mapping Network was created to share a wealth of natural resource
information and maps with communities in British Columbia, Canada. Government and
community natural resource information is integrated and made accessible through a user
friendly, interactive mapping system called Autodesk Mapguide. A series of servers are utilized
to share the workload for serving province-wide topographical base maps, high resolution
orthophotography, Canadian Hydrographic Service Charts and selected resource information.
Maps and natural resource information are “web-served” to assist communities and local
governments with landuse planning, to promote conservation and protection of sensitive habitats
and to raise awareness and respect for ecological values.

Uses and Benefits of the PCRA
There are many uses for spatially georeferenced marine habitat and fishery information. Some
examples of the business needs for this information include:
•
Habitat referrals for foreshore leases and licences;
•
Oil spill contingency planning and response;
•
Community shoreline planning and zoning;
•
Provincial coastal planning;
•
Provincial and Federal Marine Protected Area analysis;
•
Fisheries research which looks for correlation of marine resources with habitat.
The benefits to Governments and Communities are significant; requests for existing information
from Government agencies will be greatly reduced (with associated cost savings) – community
members will have a greater sense of ownership and stewardship of natural resources and will be
better informed when resource use conflict decisions are being made.
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Incorporation of Local and Traditional Ecological Knowledge
While both the federal and provincial governments have collected a wealth of information on
coastal resources and resource use along the BC coast, there critical information gaps for certain
resources and little information collected at detailed scales of resolution. The cost of doing
detailed surveys in this huge coastal area would be phenomenal, (at a recent conference at the
Institute of Ocean Sciences one participant estimated it would take 60+ years using the best
available technology just to accurately map the BC coastal seafloor and inshore). The ability to
map additional coastal resources using Local Ecological Knowledge (LEK and Traditional
Ecological Knowledge (TEK) will greatly assist BC residents in making responsible resource use
decisions. The Community Mapping Network (CMN) allows authorized users to add new LEK /
TEK as it becomes available using “on- line” data entry tools. This initiative is presently the only
marine resource information system in BC that allows on- line data entry.

Metadata
Metadata is the “data about the data” – who collected it, and when, how and why it was
collected. The PCRA system allows the user to access the accuracy of both the spatial and nonspatial information about a feature (habitat/fishe ry/species) by providing metadata in the data
records about who collected the information, how it was collected and when it was collected.
The on- line data entry tools allow for the input of new information that will come from a variety
of sources with an associated variety of accuracy and completeness, (as is the case with most
existing information sources). The system allows anyone who views the maps and data reports
to review the sources of the information and the relative accuracy of the observations. By
including detailed metadata in the PCRA, users are informed as to the accuracy and precision of
an observation and where needed use the PCRA to focus their survey efforts to improve these. In
the meantime as coastal resource use planning decisions are being considered, crudely
georeferenced or “suspected presence” of a species, fishery or habitat is better than no
information at all.
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Fisheries Resource Information
One of the main sources of information included in the PCRA is regional Fisheries Resource
Information collected and maintained under the joint efforts of the BC Provincial Government
and Fisheries and Oceans Canada (DFO).
In the late 1980s the Environmental Emergency Services Branch of the BC Ministry of
Environment, began the process of compiling marine biological information for Biological
sensitivity mapping for oil spill response. This included information the distribution of species, a
comprehensive mapping of shoreline physical characteristics and the locations where fisheries
took place. In reality there is little information on the distributions of individual marine species
other than for birds and mammals. Most of our understanding of the distributions of fish and
invertebrates is inferred from the locations of commercial and recreational fisheries for those
species. The distributions of species that we do not exploit are mostly unknown or extrapolated
from what we know of their habitat preferences.
DFO had long recognized that a significant proportion of the existing fisheries and fish habitat
information for the BC coast comes from the personal knowledge and experience of district
fisheries staff or on unpublished file material in district fisheries offices. In 1993, the South
Coast Division of DFO initiated the development of a standardized system to collect, organize
and report information pertinent to oil spill planning from fisheries staff (Booth and Rueggeberg
1994; Booth et al. 1995). This collection of Fisheries Resource Information was continued
through the 1990s and is still ongoing with regional updates roughly every five years. The
database is currently (2005) maintained and updated jointly by Decision Support Services (under
the Ministry of Sustainable Resource Management) and Fisheries and Oceans Canada’s Habitat
and Enhancement Branch. Current regional compilations include:
Region

Years collected/ updated

Strait of Georgia

1992/93, 2002-2004

Johnstone Strait

1994/95, 2002-2004

North Island Straits

1994/95, 2002

West Coast Vancouver Island

1994/95

Quatsino Sound

2002

Central Coast

1994/95, 2003

North Mainland Coast

1997, 2002

Queen Charlotte Islands

1997, 2002

The data sources used in the Fisheries Resource Information compilations include:
•

Interviews with regional DFO fisheries staff familiar with their region; the nature of their
experience and number of years associated with the study area are noted, as indicators of the
comprehensiveness of the data being provided.

•

Reports and existing databases based at least in part on personal knowledge of regional DFO
fisheries staff; these include Records of Management Strategies, annual fisheries
management strategies, and other such documents.
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A standard and methodology is used for all interviews and all interviews are conducted by a
qualified fisheries biologist. Each interviewee is provided with a series of Canadian
Hydrographic Service charts covering their area of interest and was then asked to identify
specific fish1 habitats2 , fish distributions 3 or areas of fishing activity. Where practical, the largest
scale charts available are used (usually 1:40,000 scale) used for compilation; however in the case
of fisheries that covered a broad geographical extent (e.g. offshore groundfish trawl and salmon
troll fisheries) a smaller scale chart may be used. As each area is delineated, it is assigned an
identifier and the interviewee is queried to collect relevant information concerning the area or
fishery. Interviews are conducted with at most one or two interviewees at a time. When
returning to an area for updates, the interviewees are asked to verify or comment on the old
datasets. Interviewees are also asked to search their files and archives for relevant hard copy or
digital information that may supplement their verbal knowledge.
After completion of the interviews the maps and data forms are entered into a Geographic
Information System and verified. If there is overlap or discrepancies in the information obtained
from different sources the data are scrutinized and in most instances are merged into a single
observation with two sources. The criteria used to make such decisions are (1) to give
preference to the information obtained from the individual with the most direct knowledge and
experience of the specific fishery, (2) to give preference to the information from the larger scale
chart, and (3) to preserve detail. In instances where one of the data points is part of a coastwide
dataset (e.g. the distribution of herring spawn, clam beds or kelp beds) the coastwide dataset is
kept intact and the information from other sources is maintained but kept as a separate entity.
These discrepancies are flagged to be sorted out by further field studies.
The data included in the marine fishery resources are a series of polygon, line or point themes
with common data structures. The spatial format of the theme was decided based on the nature
and precision of the georeferencing. For example, seal and sea lion haul outs are represented by
a point, coastline with herring spawn recorded as present as a line and areas where the offshore
and along shore distribution of herring spawn has been mapped are represented by a polygon
theme. The majority of layers representing fisheries are represented as polygons.
Each polygon, point or line represents an area where a particular habitat is located or type of
fishery operates. Since 2000, all data records include information that allows the user to judge
the accuracy of the mapped data (see details in following section on Metadata). Prior to this time
data formats were less standardized in terms of both metadata recorded and separation of data
layers. It is hoped that in future the format will maintain the current format.
The marine fishery resources of the BC Coast that are included in the compilations of Fisheries
and Habitat Resource Information are listed in Appendix A.

1 “Fish” and “Fish Habitats” refer here to both fish and invertebrate species and their habitats.
2 Fish habitats include eelgrass and kelp beds.
3 Fish distributions that are mapped include herring spawning areas, mouths of rivers where anadromous fish spawn

and known spawning grounds or pre-spawn holding areas of other demersal or pelagic fishes.
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DATA LAYERS

The PCRA system has been designed to include a wide variety of information on the distribution,
abundance and relative importance of marine flora and fauna, fish habitat and fisheries. A
complete list of all the data layers and their file names is included in Appendix A of this report.
The data are grouped into the following categories:

Fish Habitat Features
Kelp beds
Kelp mapped from surveys
MAFF completed aerial surveys of kelp beds for selected areas of the
Region
NE Vancouver Island (Port Hardy to Port McNeill)
Nootka Snd & Hesquiate Penninsula
Estevan Group and Campania Is
Dundas Group
N&W Graham Is
Goschen Is to Tree Nob Group
NW Vancouver Is (Nigei to Cape Scott)
Juan De Fuca Strait
Hakai Passage to Bardswell Group

province including:
Year(s)
1974, ‘78, ‘83, and ‘89
1975
1978
1978
1976
1976
1978
1988
1993

Kelp mapped from CHS Charts
In addition all kelp on the CHS charts (indicated by an icon of a kelp fond) was digitized for the
Johnstone Strait and Central Coast regions. The centre of each icon was digitized and then
buffered by 50 m. The resulting buffers were then joined. This data was collected as part of the
LUCO coastal data collection process and is in the DFO data warehouse.
Additional information on location of kelp beds
Additional information on locations of kelp beds has been collected from DFO regional staff as
part of the Fisheries Resource Information collection. This data layer includes kelp beds that do
not appear in either of the above two data layers are included as a separate data layer.
Eelgrass and other marine intertidal/shallow subtidal vegetation
Intertidal vegetation mapping by DFO Herring Section
The Department of Fisheries and Oceans (then referred to as the Department of Environment,
Fisheries and Marine Service) undertook eelgrass mapping from the 1970’s until the early 1980’s
on British Columbia’s West Coast. The Pacific Biological Station in Nanaimo, BC initiated the
project to map the shoreline marine vegetation on herring spawning grounds from aerial
photographs. The original data set was compiled with the purpose of gathering “knowledge on
the extent and type of shoreline vegetation on which Pacific herring annually deposit adhesive
eggs” (Haegele, 1975). This knowledge was to be used to estimate the size of the spawning
population (Haegele, 1975). Methods were developed for mapping in 1973 and 1974, applying
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the use of low level colour infrared and colour aerial photographs. In total, 16 sites along the
West Coast of British Columbia’s coastline were photographed and mapped between the years of
1974 and 1983. Species were classified as either Rockweed, Kelp (Brown Algae), Red Algae,
Green Algae, or Sea grasses. In cases where no distinct uni-species vegetation zones was
evident, vegetation zones were plotted according to either the:
• Single dominant type (if it occupied not less than 80% of the total area)
• Mixed vegetation zones (if two or more vegetation types each occupied more than 20% of
the total area)
• Vegetation types covering less than 20% of a zone were not included in zone
identification.
The maps from these surveys were digitized in 2002/2003 and details of the conversion process
along with a summary of the original surveys can be found on the CMN maps site:
http://www.shim.bc.ca/atlases/Eelgrass/Eelgrassmetafn.pdf
Province wide eelgrass mapping by BC Provincial Government
The only broad scale mapping project in British Columbia that includes eelgrass is the Provincial
Shoreline Mapping project, currently named CRIS (Coastal Resource Inventory Study). This
information was gathered from Oblique Aerial Video flown at tides less than one metre tide.
Eelgrass presence was rated for each shoreline unit in a somewhat subjective manner. The rating
might vary depending on the length of the unit. For example, a 10 km unit with a 500m eelgrass
bed (5%) might be classified as patchy but a unit of 1 km with 5% eelgrass (5 m) would not be
classified as present. Roughly the classes are defined as:
• Continuous: >50% of unit has eelgrass
• Patchy: 10 – 50 % of unit has eelgrass
• None: <10% (but see note above)
This method can be used to identify areas where eelgrass is present as seen at low tide periods. It
can also be used to predict the presence of eelgrass subtidally, however it cannot be used to infer
its absence. While this information can be viewed on the CMN site, data requests should be
directed towards the Ministry of Sustainable Resource Management, Decision Support Services:
http://srmwww.gov.bc.ca/dss/
Community eelgrass mapping
DFO in conjunction with Environment Canada has developed a methodology for mapping and
monitoring of eelgrass. The manual for this methodology is available on CMN site:
Precision Identification, 2002. Field Manual for mapping and monitoring eelgrass habitat in
British Columbia. Prepared for environment Canada.
The CMN site also shows community eelgrass mapping projects in BC.
Environment Canada eelgrass mapping
Environment Canada has completed extensive high resolution mapping of eelgrass in Boundary
Bay, BC using a combination of aerial photographs and ground truthing by boat. This was a one
time mapping project of the extensive eelgrass beds in this region in 1992/93. Other areas of the
province may be mapped in future. The data custodian is Michael Dunn, Pacific Wildlife Research
Centre, Environment Canada, 5421 Robertson Road, RR#1, Delta, BC, V4K 3N2. (ph) 604-940-4700,
(fax) 604-940-7022, (email) Michael.Dunn.moore@ec.gc.ca.
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Additional information on location of eelgrass beds
Additional information on locations of eelgrass beds has been collected from DFO regional staff
as part of the Fisheries Resource Information collection. This data layer named
“Herring_Spawn_FO” contains information on locations where herring spawn has occurred but
for some reason has not been recorded in one of the other compilations of herring spawn.
Typically these include small spawns in remote locations or spawns that have occurred rarely in
that location.
Special shorelines
During the collection of LEK from DFO regional staff it became apparent that they often had
intuitive knowledge of shorelines that were of special significance. This information was
recorded and linked to linear shoreline segments. The categories of “special shorelines” that have
been recorded to date include highly productive salt marshes, tidal flats and estuaries. An
additional features recorded was an inlet locally important on the central coast for its blue clay
substrates. The list of special shoreline categories can be added to if new ones are identified.

Fish and Invertebrate Distributions
Generally, the distribution of marine fish or invertebrates are not monitored directly but inferred
from the areas where fisheries take place. There are however a few exceptions, including:
§

Locations of clam beds;

§

Location and intensity of Herring spawn;

§

Estuaries of eulachon bearing streams;

§

Estuaries of salmon bearing streams;

§

Locations of pre-spawn holding areas for salmon and herring;

§

Migration routes for returning salmon;

§

Locations where juvenile fish concentrate;

§

Unusual concentrations of fish and invertebrates.

Some of these distributions have been mapped on a systematic basis (e.g. herring spawn, salmon
escapement and clam beds) while others are done on an opportunistic basis where a fortuitous
field observation was made (e.g. concentrations of juvenile fish or unusual concentrations of fish
or invertebrates). These are described more fully in the following sections.
Clams beds
DFO maintains a Clam Atlas of clam beds on the south coast of BC. The Atlas maps clam beds
identified by DFO regional staff. Currently the Atlas only maps beds south of Cape Caution. Ric
Harbo (South Coast 250-756-7268) manages this database. A series of three documents
catalogue clam beds identified prior to 1997.
R. Harbo, K. Marcus and T. Boxwell. 1997. Intertidal Clam Resources (Manila, Littleneck and
Butter Clam).
§

Volume I: The West Coast of Vancouver Island. Can. M Rpt. Fish. Aquat. Sci. No.
2416: vii + 116 p.
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§

Volume II: The Southern Inside Waters of Vancouver Island and the British Columbia
Mainland. Can. M Rpt. Fish. Aquat. Sci. No. 2417: viii + 245 p.

§

Volume III: The Northern Inside Waters of Vancouver Island and the British
Columbia Mainland. Can. M Rpt. Fish. Aquat. Sci. No. 2418: viii + 79 p.

Additional beds have been identified and added to the data layer from interviews with DFO
regional staff as part of the Fisheries Resource Information collection. Where it exists, the
original clam atlas beach number as listed in the 1997 publications is cross-reference in this
database. As part of the updating of fisheries information the clam atlas digital files were fitted to
the TRIM base map.
Herring Spawn
Herring spawn 1 km segments
The main database layer is based on a DFO in house dataset which references all recorded
occurrences of herring spawn since 1928 referenced to points which roughly divide the coast into
1 km segments. For Statistical Areas 1-6, 12 and 27 these points have been reviewed and moved
so that they are georeferenced to the provincial TRIM coastline. Other areas of the coast are
referenced to an old (and not too accurate CHS coastline). There are plans to eventually
reference the remaining herring spawn segments but there is no funding for this a present (and
none in the foreseeable future). Once the segments have been attached to the TRIM shoreline
they can be used to cut the shoreline into linear segments with the above attributes. The structure
of this database is listed below. Bruce McCarter at PBS (250-756-7198) is the current manager
of this database. Further information is available in Hay et al. (1989) and Hay and McCarter
(2001).
Fields in the herring spawn database (as represented by points or dive transects).
Field Name

Description of the Field

KMLOCATION

Unique DFO code for individual points

HER_SECTION

DFO Herring Section statistical area

SUB_AREA

DFO statistical area number

KM

DFO km segment number within Herring Section

DOY

Mean weighted date

FREQ

Number of years spawn recorded between 1928 and 2001

INDEX

Spawn Habitat index (function of coverage, intensity and frequency)

RANK

Relative importance of spawn compared to all other rated spawns on the BC coast

This database includes both information collected from dedicated spawn surveys as well as
anecdotal observations of DFO regional staff. The positions and extent of spawn may therefore
not always be exact. The fact that the database consists of over 50 years of records for many
areas does compensate for this lack of precision.
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Polygons of Herring Spawn
While surveying for herring spawn, DFO regional staff often make sketch maps of the
distribution of spawn in areas with significant spawn. These are passed on to the DFO Herring
section where they have been converted into digital polygons referenced to the TRIM coastline.
The sketch maps from which these polygons were created were only available only for selected
areas and were not produced every year. They tend to be located in areas of the most consistent
and abundant spawn. In some areas there are 20 or more years of polygons.
Polygons of herring spawn have been stored both as separate layers representing spawn in a
single year as well as a layer where polygon from every year have been overlain. The associated
database includes one field for each year that indicates if spawn was present in that year (or not)
and a summary field that indicates how many of the years spawn was present for. By displaying
the layer with a graduated colour based on this field you can get a visual representation of the
relative abundance of spawn. However, to get information on the intensity of the spawn you will
need to refer back to the km segment database.
Herring spawn dive survey transects
The DFO Herring Section currently organizes annual dive surveys for herring spawn in those
areas with consistent, significant spawn. These transects have been digitized and are referenced
to CHS charts. Locations of transects have been digitized for surveys prior to 1997 for most of
the coast and up to 2002 for the SoG. Eventually the herring section hopes to convert these into
areas of spawn rather than just the transects with spawn along them. The same attributes as are
attached to the herring spawn km database are attached to points along these transects. This
dataset, based on actual survey data, may eventually take over from the km segments dataset
which is based primarily on anecdotal information.
Additional information on locations of herring spawn
Additiona l information on shorelines where herring spawn has been observed by DFO regional
staff has been recorded as part of the Fisheries Resource Information collection. This data layer
contains information on locations where herring spawn has occurred but for some reason has not
been recorded in one of the other compilations of herring spawn. Typically these include small
spawns in remote locations or spawns that have occurred rarely in that location.
Estuaries of eulachon bearing streams
These locations have been mapped from the DFO and Royal BC Museum databases of eulachon
bearing streams. The streams themselves are based on the provincial TRIM base map.
Estuaries of salmon bearing streams
The streams are identified from the DFO salmon escapement database which gives the estimated
annual escapement of each salmon species by stream segment. The streams themselves are based
on the provincial TRIM base map.
Adult salmon migration routes and holding areas
Migration routes and holding areas of adult salmon on their way back to their natal rivers to
spawn are mapped from interviews with regional DFO staff as part of the Fisheries Resource
Information. Migration routes tend to be better known and delineated in restricted coastal
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waterways such as along channels and passages than in open waters such as the Strait of
Georgia.
Locations where juvenile fish concentrate
During interviews with regional DFO staff as part of the Fisheries Resource Information data
collection, staff members occasionally identified sites where they had opportunistically observed
large concentrations of juvenile fish. Species observed included Herring, Salmon (unspecified),
Coho Salmon, Chinook Salmon, Chum Salmon, Pink Salmon, Sockeye Salmon, Rockfish, and
Eulachon. While DFO does occasionally carry out surveys of juvenile fish, this information has
not been incorporated into the Pacific Coastal Atlas.
Unusual concentrations of fish and invertebrates
Another set of opportunistic observation colleted from DFO regional staff included sitings of
unusual concentrations of fish or invertebrates while out in the field. To date the types of
concentrations observed include:
§ Areas where squid concentrate for spawning
§ Areas where jellyfish concentrations have been observed
§ Beaches which have large seed populations of clams but which are not harvested
§ Urchin barrens (areas where urchins have concentrated in such large numbers that the bottom
is barren of marine algae)
§ Locations of bioherm forming sponges
§ Intertidal concentrations of sandlance

Marine Mammal Distributions
Where possible, marine mammals were mapped from known distributions based on survey and
other sighting data. Where this data was not
available, habitat models were used to predict the
relative abundance in various areas. Knowledge of
marine mammals is limited, and species will likely
occur in many areas not identified.
Harbour seals
DFO harbour seal surveys
DFO conducts Harbour seal surveys from overflights in selected regions of the province (see
figure below). Seals are counted on their haulouts
during low tides during the summer months. These
surveys are primarily done to access population
numbers and do not identify every haulout on the
coast. The surveys are generally repeated every 5
years. The surveys and databases are managed by
Peter Olesiuk at the Pacific Biological Station
(250-756-7254).
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Sea lions
DFO sea lion surveys
DFO conducts sea lion surveys from over-flights of known seal haulout locations. Seals are
counted on their haulouts during low tides during the summer months. These surveys are
primarily done to access population numbers and do not identify every haulout on the coast. The
surveys are generally repeated every 5 years. The surveys and databases are managed by Peter
Olesiuk at the Pacific Biological Station (250-756-7254).Databases of numbers Steller and
California sea lions at rookeries, haulouts and rafting sites is maintained by DFO marine
Mammal unit at PBS based on surveys of known locations. Census data separate sea lions by
species and provide separate numbers for pups.
Additional information on the distribution of seals and sea lions
Additional information on where seal and sea lions concentrate has been mapped from LEK of
DFO regional staff. Only those sites not included in DFO Marine Mammal Unit surveys are
included in this dataset and they are likely to be minor concentrations.
Cetaceans
Information on the distribution of Cetaceans is less readily available than for other marine
mammals as they tend to be highly mobile and do not haul out on land. For most cetacean
species their distributions are mapped from a combination of LEK of DFO researchers, sighting
data and habitat models derived from what we know of a species habitat preference. From this
areas of probable high, low and moderate use have been derived for the following species:
Common Name

Scientific Name

Comments

Killer whale

Orcinus orca

Three races in BC – transient,
resident and offshore. Only the
distribution of the resident race is
currently mapped.

Gray whale

Eschrichtius robustus

Humpback whale

Megaptera novaeangliae

A fair number of sightings for these
species, supplemented by habitat
models.

Pacific white-sided dolphin

Lagenorhyncus obliquidens

Species tends to form large
concentrations but location of these
concentrations change dramatically
over time.

Harbour porpoise

Phocoena phocoena

Dall’s porpoise

Phocoenoides dalli

Poor sighting database for these
species; distribution based largely
on know habitat preferences.

Fisheries
With the exception of herring spawning, clam beds and rivers that support anadromous fish
stocks, the only available systematic information we have on the distribution of fish species is
harvesting data. While we do have some understanding of the habitat preferences of harvested
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species, it is insufficient to allow estimation of species distributions with any confidence. The
distributions of these fisheries resources have therefore been inferred from the intensity of
harvesting. The weakness of this approach is that harvesting intensity in some areas is a
reflectio n of quotas and management controls.
This information is also useful in coastal planning where it is important to know what areas are
critical to a fishery when selecting areas for alternate uses such as protected areas or tenured
activities such as fish farms or log handling. Two types of information on the locations of
fisheries were collected:
•

•

Anecdotal information on the locations where commercial, First Nations and sport
fisheries take place as indicated by DFO regional staff. This also includes information on
the locations in the Strait of Georgia frequented by sport fishermen during the summer
months as observed from DFO aerial creel surveys.
Extrapolation of the distribution of fisheries from commercial landing data tabulated by
DFO statistical sub-areas. Currently this information is only available for DFO statistical
area 12 (NE Vancouver Island).

Anecdotal information on the location of fisheries
The layers mapping the location of fishing areas include information on the timing and intensity
of use specific to that location. In most instances, a single fishery consists of a series of locations
(several polygons) with specific timing and levels of resource use indicated for each location.
Fisheries targeting the same species but with differences in harvesting methods and/or timing 4
are kept as separate data layers. The fisheries mapped as part of the Pacific Coastal Atlas have
been organized according to the following table:
Species
Salmon

Gear types

Data Layer

Gillnet, Seine Salmon net
Troll

Salmon Troll

Sport

Sport Fishery

Groundfish: Rockfish, Ling cod, Sablefish, Hook & Line
Dogfish, Halibut

Groundfish Hook & Line

Groundfish: Rockfish, Ling cod, Sablefish, Trawl
Pacific cod, Sole, Walleye Pollock, Hake

Groundfish Trawl

Groundfish: Rockfish, Ling cod, Halibut

Sport

Sport Fishery

Dungeness Crab, Red rock crab, Box
crab, Tanner crab

Trap

Crab Fishery

Shrimp and Prawns

Trap

Prawn Trap Fishery

Trawl

Shrimp Trawl Fishery

Dive

Geoduck Dive Fishery

Geoduck

4 For example the herring spawn, food and bait fisheries and the salmon gillnet, seine and troll fisheries.
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Gear types

Data Layer

Clams (manila, littleneck, butter, razor)

Hand

Clam Beds

Sea urchins (red and green)

Dive

Urchins Dive

Sea cucumber

Dive

Cucumber Dive

Tuna

Hook & Line

Tuna troll fishery

Herring

Seine

Herring Fishery (food, roe and bait
fisheries)

Pens

Herring ROK fishery (roe on kelp)

Dive, hand

Octopus fishery

Octopus

First Nations food fisheries have been kept as a single layer for all species and compiled in a
separate layer to commercial and recreational fisheries.
Locations of fisheries based commercial landing data
As part of the collection of information for the North Island Strait coastal planning process catch
data for DFO statistical area 12 was compiled and mapped for 9 fisheries. This data is displayed
as polygons based on DFO statistical sub-areas classified on the basis of the total landings in that
sub-area from 1994-98. The catch data are displayed and normalized by the area of the sub-area
that is within the depth range for that fishery and expressed as lbs/hectare.
Although the location of the fisheries within the sub-areas is proprietary data, available only
from confidential log book records, it is known that several of the fisheries are limited to certain
depth strata. The size (ha) of sub-areas was therefore determined for each fishery individually
depending on the depth range of the fishery. Dive fishery catch data (sea cucumbers, geoducks,
red urchins, green urchins, and octopus) were limited to those portions of the sub-area with
depths <20m; Crab trap fishery catch data were limited to those portions of the sub-area with
depths <50m and rockfish and prawn fishery data were limited to those portions of the sub-area
with depths <100 m. The landings for the shrimp trawl fishery were applied to the entire subarea
with no depth restriction.
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DATA SOURCES

The data that has been incorporated into the Atlas has come from a number of sources. These
include data that have already been georeferenced into a GIS during past one time data
compilation projects, existing georeferenced databases that are part of an ongoing data collection
system, and new data that are coming in from certified data providers. These data sources are
summarized in Table 1 below and discussed in greater detail in the following sections.
Table 1: SHIM data sources.
Database
Fisheries Resource Information – Strait of Georgia 5
Fisheries Resource Information – West Coast Vancouver
Island
Fisheries Resource Information –Johnstone Strait

Source
One time data compilation in 1994 under
contract to the Provincial Government

One time data compilation in 1995 under
contract to the Provincial Government

Fisheries Resource Information – Central Coast
Fisheries Resource Information – North Coast

One time data compilation in 1997 under
contract to the Provincial Government

Fisheries Resource Information – Quatsino Sound

One time data compilation in 2002 under
contract to DFO

Fisheries Resource Information – North Island Straits

One time data compilation in 2002 under
contract to DFO

Kelp surveys

One time survey of Kelp beds in selected
locations of the BC coast by the Provincial
Government (MAFF)

Kelp beds from CHS charts

One time digitization of all kelp beds from
CHS charts (1995-97)

Intertidal/shallow subtidal vegetation

One time survey of marine vegetation in
areas of significant herring spawn.
Produced by DFO staff in Herring Section
at Pacific Biological Station and digitized by
various agencies

Herring Spawn alongshore locations and importance index
Herring Spawn extent

Ongoing database maintained by DFO staff
in Herring Section at Pacific Biological
Station.

“Clam Atlas” – location and level of use of clam beds

Ongoing database maintained by DFO staff
in South Coast Division

Catch statistics for log book fisheries by sub-area

Ongoing database maintained by DFO staff
in Biological Data and Analysis Division

Seal and Sea lion haulouts

Ongoing database maintained by DFO staff
in Marine Mammal Group at Pacific
Biological Station

5 This dataset has not been incorporated at this time but it is hoped that it will be in the near future.
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Biological Station

Marine habitat, fish/invertebrate and fishery information

Proposed on-line data entry from certified
individuals and organization into SHIM.
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DATA ATTRIBUTES

A number of attributes are used to describe each data record. These include information on the
location, timing and intensity of use as well as details on species, fishing gear used and other
relevant information. Not all fields are used for all data layers, only those that are relevant. List
all of the data description fields; the next section describes those data fields that describe how the
information was collected and its accuracy and precision.
Table 2: Fields used to describe attributes of areas represented by individual data records.
Field Name

Description of the Field

CoastID

Unique coastwide ID (Stat -Area * 100000 + ID)

ID

Original source identification number

POLYGON/
LINE_NO

Unique polygon or line number

SITE_NO

Unique site # (use DFO official site # if available) (Seal or SeaLion layers only)

SURV_NO

DFO survey # if part of official survey (Sea_otter, Seal or SeaLion layers only)

CLAMATLAS

Number assigned in published clam atlas – for layer Clam_Beds only

LOCATION

Descriptive location

CHART_NO

CHS chart number

STAT_AREA

DFO statistical area number

SUB_AREA

DFO statistical sub-area number

HER_SECTION

DFO Herring Section statistical area number (herring spawn layers only)

SPECIES

List of species present; for each layer a specific pick list of available species is
provided. Note individual logical (Yes/No) fields are added for each relevant species
to aid in queries. See Table 3 for species fields for each fishery or resource.

SPECIES_OTHER

List of additional species present; as for the field SPECIES, for each layer a specific
pick list of available species is provided.

RUN

Name of Salmon Run (for layers Salmon_Holding and Salmon_Migration_Route)

FISHERY_TYPE

Type of fishery, used in layer Herring_Fishery to distinguish roe, bait and food
fisheries

GEAR

Gear type used in fishery; for each fishery a pick list of applicable gear is provided.

SPAWNING

Presence of spawning herring (Herring_Fishery layer only)

COMMERCIAL

Relative importance to the commercial fishery

SPORT

Relative importance to the aboriginal fishery

ABORIGINAL

Relative importance to the sport fishery

RI

Overall Relative importance of fishery, or species presence or concentration. This is
a subjective measure and is relative to the DFO Staff persons area of experience –
usually a DFO statistical area.
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START

Julian day fishery, spawning, or concentration starts (1 if year round, 0 if no
information)

CLOSE or END

Julian day fishery closes or, spawning, or concentration ends (365 if year round, 0 if
no information)

TIMING

Description of when fishery takes place or when concentration or spawning occurs

COMMENTS

Any comments specific to record.

The layer used for identifying kelp beds has an additional fields to indicate if the area has been
surveyed by the province in the past. This field “SURVEYED” is a logical field and can be
entered by the compiler or by the database manager at a later date.
The following table (Table 3) lists the individual logical fields used to indicate which species are
taken at the location described by a data record. This approach is only used in mixed species
fisheries.
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Table 3: Species selections and other fields for individual fisheries or resources.
Layer

Field Name

Description of the Field

Clam_Beds

MANILA

Presence of Manila Clams confirmed

LITTLE_NECK

Presence of Little Neck Clams confirmed

BUTTER

Presence of Butter Clams confirmed

RAZOR

Presence of Razor Clams confirmed

DUNGENESS

Presence of Dungeness crab fishery

RED_ROCK

Presence of Red Rock crab fishery

TANNER

Presence of Tanner crab fishery

DOGFISH

Presence of Spiny dogfish longline fishery

ROCKFISH

Presence of Rockfish hook & line fishery

LINGCOD

Presence of Lingcod hook & line fishery

SABLEFISH

Presence of Sablefish trap/longline fishery

HAGFISH

Presence of Pacific hagfish fishery

HALIBUT

Presence of Pacific halibut fishery

SCHOOL

Time when schooling eulachon are present

SPAWN

Time when eulachon spawn in river

LARVAE

Time when eulachon larvae are moving through area

OTHER_SP

Salmon Species other than pink

OTHER_TIM

Timing of concentrations of other species

PINK_EVEN

Timing of Even Year Pink salmon

PINK_ODD

Timing of Odd Year Pink salmon

UNSPECIFIED

Species harvested was not specified

RED_URCHIN

Red Urchin harvested

GREEN_URCHIN

Green Urchin harvested

PURPLE_URCHIN

Purple Urchin harvested

Crab_Fishery

Groundfish_Hook_Line

Eulachon_Holding

Salmon_Holding

Urchin_Fishery
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The layer HSpawn_Pnt is based on a DFO in house dataset which references all observed
occurrences of herring spawn since 1928 referenced to points which roughly divide the coast into
1 km segments. These points have been moved so that they are georeferenced to the provincial
TRIM coastline. The structure of this database reflects the data recorded by the DFO Herring
Section at the Pacific Biological Station and is listed below.
Table 4: Fields in the layer for herring spawn as represented by points (HSpawn_Pnt).
Field Name

Description of the Field

KMLOCATION

Unique DFO code for individual points

ACCURACY, LOCATION, STAT_AREA,
SUB_AREA

See

HER_SECTION

DFO Herring Section statistical area

SUB_AREA

DFO statistical area number

KM

DFO km segment number within Herring Section

DOY

Mean weighted date

FREQ

Number of years spawn recorded between 1928 and 2001

INDE X

Spawn Habitat index (function of coverage, intensity and
frequency)

RANK

Relative importance of spawn compared to all other rated
spawns on the BC coast

SOURCE_1, DATA_DTE, MAP_DTE,
COMPILER

See

Table 2 and Table 8.

Table 2 and Table 8.

A separate data layer Hspawn_Shore, was created to amalgamate all of the herring spawn into
one layer referenced to shoreline segments. This layer is created by the manager of the Atlas and
includes all available information on the location, timing, intensity and frequency of herring
spawn. It is intended to be viewed but not updated by users of the atlas. The layer has all of the
fields included in the layer Hspawn_Pnt as well as the following two additional fields:
•

FOLOC_NO which links the coastal line segment to the layer HSpawn_FO_shore

•

KMLOCATION which links the coastal line segment to the layer HSpawn_Pnt

The layer Groundfish_Trawl has a unique field structure as it tries to capture the nature of the
trawl fishery which includes seasonal fishing to spread effort over the year and mixed species.
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Table 5: Fields in the layer for Groundfish Trawl Fisheries (Groundfish_Trawl).
Field Name

Description of the Field

CoastID, ID, POLYGON, ACCURACY,
OBS_METHOD, LOCATION, CHART_NO,
STAT_AREA, SUB_AREA

See

LICOD_UL

Use level rating for Lingcod

PACOD_UL

Use level rating for Pacific cod

ROCKF_UL

Use level rating for rockfish

ROCKF_SP

Rockfish species identified in fishery

SOLED_UL

Use level rating for deep water soles

SOLED_SP

Deep water soles species identified in fishery

SOLES_UL

Use level rating for shallow water soles

SOLES_SP

Shallow water soles species identified in fishery

HAKE_UL

Use level rating for Pacific hake

POLLOCK_UL

Use level rating for Walleye pollock

DOGF_UL

Use level rating for Spiny dogfish

SABLE_UL

Use level rating for Sablefish

Q1_UL, Q2_UL, Q3_UL, Q4_UL

Use level rating for polygon by year quarter

Q1_SPECIES, Q2_SPECIES,
Q3_SPECIES, Q4_SPECIES

Species assemblage fished at location in by year quarter

COMMENTS, SOURCE_1, SOURCE_2,
DATA_DTE, MAP_DTE, COMPILER

See

Table 2 and Table 8.

Table 2 and Table 8.
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The layers Salmon_Troll and Salmon_Net are also unique in that they have the capability of
identifying the run (natal river) of salmon being targeted. This information can be important as
openings for salmon fisheries are typically designed around the movements of returning salmon.
The fields unique to these layers include:
Table 6: Fields in the layers for commercial salmon fisheries (Salmon_Net, Salmon_Troll)
Field Name

Description of the Field

CoastID, ID, POLYGON, ACCURACY,
OBS_METHOD, LOCATION, CHART_NO,
STAT_AREA, SUB_AREA

See

FISHR_TYPE

Local name for fishery

Table 2 and Table 8.

SO_SEINE
SO_GILL
SO_TROLL
CM_SEINE
CM_GILL
CM_ TROLL
CH_SEINE
CH_GILL
CH_ TROLL
PI_SEINE

Logical fields indicating the presence of Sockeye (SO),
Chum (CM), Pink (PI), Coho (CO) and/or Steelhead
(ST) in the catch at the location represented by the
record for the Seine, Gillnet (GILL) or Troll Fishery.

PI_GILL
PI_ TROLL
CO_SEINE
CO_GILL
CO_ TROLL
ST_SEINE
ST_GILL
ST_ TROLL
SEINE_SP
GILLNET_SP

Comments on species targeted by seine, gillnet or troll
fleet at the location represented by the record.

TRIOLL_SP
SEINE_RI
GILLNET_RI

Use level rating (RI) for seine fishery , gillnet fishery or
for troll fishery

TROLL_RI
RI, START, CLOSE, TIMING

See

Table 2
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RIV_LOC1, RIV_LOC2, RIV_LOC3, RIV_LOC4

Name of river salmon are returning to (1 to 4 rivers)

PERC1, PERC2, PERC3, PERC4

Percent salmon returning to river (1 to 4 rivers)

SPEC1, SPEC2, SPEC3, SPEC4

Species retuning to river (1 to 4 rivers)

COMMENTS, SOURCE_1, SOURCE_2,
DATA_DTE, MAP_DTE, COMPILER

See

Table 2 and Table 8.

The seal and sea lion layer databases are designed with a unique structure to capture information
on the behaviour and age structure (pups vs. adults) at individual locations. The fields for the
point layers describing concentrations of seals or sea lion concentrations include:
Table 7: Fields used to describe Seal and Sea Lion concentrations.
Field Name

Description of the Field

CoastID, ID, SITE_NO, SURV_NO,
ACCURACY, OBS_METHOD,
FIELD_METHOD, PHOTO, GPS,
GPS_DIFFERENTIAL, GPS_MODEL,
LOCATION, CHART_NO,
STAT_AREA, SUB_AREA

See

Table 2 and Table 8.

NUM_SEALS

Maximum # of seals counted at site

S_STELLER

Maximum # of Steller sea lions recorded from summer surveys

S_PUPS

Maximum # of Steller sea lion pups recorded from summer
surveys

W_STELLER

Maximum # Steller sea lions recorded from winter surveys

W_CALIFOR

Maximum # California sea lions recorded from winter surveys

W_SEALION

Maximum # of California and Steller sea lions combined
recorded from surveys

ACIVITY

Activity of seals or sea lions around site

RI

Rating for relative importance of site based on the maximum
number of seals or sea lions sited at site at any time.

TIMING

Description of when sea lions are present

START

Earliest day sea lions present (Julian Day - 1 if year round, 0 if
no information)

END

Latest day sea lions present (Julian day 365 if year round, 0 if no
information)

COMMENTS, SOURCE_1,
SOURCE_2, DATA_DTE, MAP_DTE,
COMPILER

See

Table 2 and Table 8.

The RI ratings for seals and sea lions were based on the maximum number of animals observed
at a site. The ratings were decided based on the typical numbers seen at sites coastwide.
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Seals

Sea Lions

0= no seals observed

0= no sea lions observed

1= Low: Less than 30 Seals

1= Low: Less than 100 Sea lions

2= Moderate: 30 to 100 Seals

2= Moderate: 100 to 400 Sea lions

3= High: Greater than 100 Seals

3= High: Greater than 400 Sea lions

The activity of the seals or sea lions around the site is selected from a pick list that includes the
following choices:
Activity
Hauled out
Swimming near haulout
Swimming in general area
Travelling
None recorded
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METADATA

Metadata attached to each data record provide information that enables the user to judge the
accuracy and precis ion of that record. The metadata includes the following fields that are
described in more detail below:
Table 8: Fields used to describe the temporal, spatial and biological accuracy and precision
of the data.
Field Name

Description of field

Accuracy

Spatial accuracy of the mapped data

Obs_Method

How did source gain their knowledge of this data record?

Field_Method

If data was collected by field survey, what type of survey was it?

Field_Sampling_Method

If samples were taken during field survey, what were they?

Photo

Was a photo taken to corroborate observation?

GPS

Was GPS used to map spatial location of observation?

GPS_Differential

If GPS was used was it differentially corrected

GPS_Model

If GPS was used what was the GPS model name?

Source (_1, _2, _3)

What was the main and corroborating sources of the data?

Data_Dte

On what time frame was this observations based?

Map_Dte

When was the data compiled into the Atlas?

Compiler

Who compiled the information into the Atlas?

Accuracy
The accuracy with which the data has been mapped is recorded as a subjective value in this field.
If the data are added from an existing database, or if the data are digitized from hard copy CHS
charts or other maps, then the following pick list is provided for selecting the data accuracy:
Code

Map Accuracy

1

Location measured using GPS (see GPS model and accuracy fields)

2

Location generalized from DFO log book lat/long positions

3

Location indicated to 2 mm on chart at chart scale

4

Alongshore location indicated to 2 mm on chart at chart scale; across shore accuracy unknown

5

General location only; rough sketch on chart or place name (5 mm on chart at chart scale)

6

Tied to shore unit or other shoreline segment

7

Tied to DFO Statistical Sub-area

8

Tied to DFO Statistical Area

9

Alongshore location indicated to 5 mm at chart scale, across shore accuracy unknown

10

Vague location only (1-2 cm on chart at chart scale)
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The chart scale is linked to the CHS chart number that is recorded in a separate field. A list of all
CHS charts and the associated scale are included in the Atlas database.
If, however, the data are entered on line via screen digitizing at the SHIM web site (and are
therefore not linked to the accuracy of a chart or GPS, the following choices are provided for
recording the spatial accuracy of a mapped location:
•

General Location only (1 km accuracy)

•

Good alongshore accuracy (10-20 m), offshore extent unknown or to 250 m

•

Good alongshore and offshore accuracy (10-20 m in both directions)

Obs_Method
The method used to georeference and describe the area is also chosen from a pick list with the
following choices:
Code

Method used to collect data

1

field work, measured directly

2

personal observations

3

second hand knowledge

4

published or compiled information

5

traditional knowledge

“Personal observations” are differentiated from “field work, measured directly” in that the first is
an incidental observation while the latter is a dedicated field survey such as a habitat assessment
or herring spawn dive survey. “Traditional knowledge” implies that it is a collective knowledge
of a group of person such as a First Nations group. Both “second hand knowledge” and
“published and compiled information” are one step removed from the original observer; the
difference lies in that the former is verbal while the latter is based on a report, map or database.
If the observation method is based on “published or compiled information” the details of source
of that information should be contained in the “Source” field of the data record.

Field_Method
If the field “Obs_Method” is indicated as “Field_Work” (code 1)6 then the nature of the field
work should be indicated in the field “Field_Sampling_Method” (see below).

6 This field can also be used if the “Obs_Method” is “published or compiled information” (code 4) and it is known

that field work was used to originally collect the data.
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Code Field technique used to collect data
0

N/A

1

Shore based surveys

2

Aerial Surveys

3

Boat Surveys

4

Dive Surveys

5

Air photo interpretation

6

Aerial Video Interpretation

Field_Sampling_Method
If the field “Obs_Method” is indicated as “Field_Work” (code 1) then if field samples were
collected the nature of these samples should be indicated. If no samples were taken or if the
observation is not based on a field survey then the field should be left at its default value of
“N/A” (code 0).
Code

Field Sampling Method

0

N/A

1

photos

2

video

3

transects

4

quadrats

5

seine net

6

dip net

7

trap

8

bottom grab

Photo
This is a logical field (Yes/No) that indicates if a photo has been taken of the habitat, fish or
fishery being mapped at the location of a data record. This is provided as an additional method
of data verification. Provision is made on the on line data entry site of the Atlas for submitting a
digital photo over the Internet. This photo can then be displayed when the data record is queried.

GPS
This is a logical field (Yes/No) that indicates whether or not a GPS was used to georeference the
spatial extents of the data record. It is intended that in the near future, provision will be made on
the Atlas on line data entry site for submitting the spatial extents of a data record as a GPS file.
At present this information gives some indication of the spatial accuracy of a data record and the
spatial extents and attributes of records can be submitted digitally in standard GIS format.
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GPS_Differential
This is a logical field (Yes/No) that indicates whether or not the GPS used had differential
correction either in the field or back in the office.

GPS_Model
If a GPS was used in georeferencing the spatial extents of the data record, then the make and
model number, plus any user modifications, should be indicated in this field.

Source
A main source (Source_1) and up to two corroborating sources (Source_2, Source_3) can be
entered for every data record. A source can be a person, published or unpublished report or map,
or a database. The details of each source must be added prior to use in a separate data file
“Sources”. This file has the following data fields:
Field Name

Field Type

Field Length

Description:

Source

Text

25

Source Reference

Full Citation

Text

250

Full citation for report or publication or map

Name

Text

50

Name of person interviewed or custodian of data

Position

Text

100

Official Title of person

Organization

Text

100

Title of department, ministry or other organization

Sector

Number

Numeric code for sector person belongs to (see below)

Experience

Memo

Relevant Experience and Responsibilities

Year_Start

Number

Year started or # of years at current or related job in area

The pick list for the sector to which the source belongs is given below.
Sector

Description of Sector

11

Government - research

12

Government - management/enforcement

21

Traditional Knowledge - First Nations

51

ENGO

31

Non-government Expert - science research

41

Industry - commercial fisheries

42

Industry - recreational fisheries

43

Industry - aquaculture

44

Industry - ecotourism

61

Individual - recreational fisher

32

Non-government Expert - tourism research

22

Traditional Knowledge - Community
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Data_Dte
Date of when the observations or field studies were made. May be a range of years if it is based
on a time series of data or a period over which observations were made.

Map_Dte
Date when data were first gathered by Compiler from the data source. If the data were already in
the atlas but have been updated or verified since the initial compilation, then this date should be
recorded.

Compiler
Name of person responsible for compiling the information and submitting it to the Atlas. In
order to submit information to the Atlas, a person must be certified by DFO. The certification
process is under development but will include a training program and requires a certain degree of
expertise or knowledge in marine resources, GIS and data management. Once certified an
individual’s name is added to the list they are provided with a user id and password for on line
data entry over the CMN/PCRA web site. A data table with metadata on each compiler is
required before a compiler can enter data. The fields in this database include the following
details that indicate to the user who the compiler is and how to contact them.
•

Name of compiler

•

Position of compiler in organization

•

Organization compiler belongs to

•

Postal Address

•

Email address

•

Phone number
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USERS MANUAL FOR ONLINE DATA ENTRY
The PCRA database should ideally be as up to date as possible. Habitat, fishery resources and
fishing activity can change in location and intensity over time. It can be important to know both
the current conditions and the way in which these features have changed over time. It is hoped
that Fisheries and Oceans’ staff and knowledgeable people living in coastal communities will
utilize tools developed for online data entry. This will help ensure that important coastal
resource information will be kept up to date and relevant.
Step1: Install the Autodesk Mapguide Viewer:
If you haven't already done so, download the Mapguide Viewer from Autodesk.

•

Go to http://www.mapguide.com/Downloads/

•

Fill- in the user information

•

You must use Microsoft Internet Explorer AND ActiveX Control Viewer

•

Download the file MGControl60.EXE onto a temp directory on your computer

•

Once downloaded, locate the file on your computer and double-click on it to start the
installation.

•

You might have to close and re-open your browser after the installation is completed.

•

You must set your browser security to Medium (Under “Tools, -> Internet Options,
Security tab).

•

If you are not familiar with the MapGuide Viewer, there is a comprehensive HELP
library available, just click the right mouse button (while the mouse is over the map) and
select About->Help Contents

•

If you are using a computer behind a firewall, you might have trouble accessing the
functions of the atlas. Ask your System Administrator for assistance.

Step 2: Go to the Community Mapping Network:
Go to: www.shim.bc.ca :
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Select “Maps and Data Entry”, then select the “Pacific Coastal Resources Atlas”: The PCRA
system will be available through a map showing the coast of British Columbia as seen below
providing the Autodesk Mapguide Viewer was installed correctly. When the PCRA system is
running you will be able to view all the spatial and attribute data by using the tools and functions
described below.
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LAYERS:
•

In the left hand margin beside the map window (gray area), map layers are orga nized into
layer groups. Layer groups can be collapsed or extended by double-clicking on the layer
group’s heading OR by right clicking on any layer and selecting Expand or Collapse from
the drop down menu.

•

Layers and layer groups can be turned on and off by toggling the square in front of them.
Right-click on the layer’s heading or the layer group’s heading for more options (turn on
and off, collapse, etc)

•

More layers become available as you zoom in. To see the list of layers available, click on
the “Metadata” tab.

•

Contrary to the “base map” layers, the "Online Data Entry" layers are “updateable” ->
new features can be added, updated, or deleted directly on the web.

STATUS BAR:
•

Refer to the bottom off the viewer for additional information such as coordinates of the
mouse location, number of features currently selected, the current scale and the size of
the map area. If you don’t see this information, right-click anywhere on the map and
select About -> Preferences. You can toggle on and off the various elements on the
status bar.
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THE “RIGHT-CLICK” MENU:
•

Additional Options are available by right-clicking anywhere on the map.

•

Print and Page Setup

•

Copy (A very useful tool to copy the map image to the clipboard and then pasting the
image into a Word or a Power Point presentation.) or Copy the URL and send it via email to a colleague to direct him/her directly to the area of interest (like a bookmark)

•

Bookmarks: add a bookmark so that you can return to the same area without having to
zoom, pan etc.

•

Select: Select elements on the map

•

View: A report (you must select a feature on the map first), Distance (measure a distance
from one point to another)

•

Zoom: Zoom to a specific scale, or to a specific feature on the map

•

About: Preferences: This allows you to choose whether you want the mouse position
coordinates displayed in the bottom left corner of the screen, and whether you want your
mouse position to appear as latitude and longitude or Projection (UTM) coordinates.

MAPPING TOOLS:
Button Command

Description

COPY > COPY

Copy the current map view to the Clipboard.

SELECT

Select a feature in the map.

PAN

Slide the map around to display areas that are outside of the
current view.

ZOOM > ZOOM

Zoom in by a magnification factor of two on the point that you
click, or zoom in to the rectangular area you draw with the
mouse.

ZOOM > ZOOM OUT

Zoom out by a magnification factor of two from the point you
click to display a larger area of the map.

ZOOM > ZOOM PREVIOUS

Return to the previous zoom magnification and location.

ZOOM > ZOOM GOTO

Zoom to a specified location.

ZOOM > UNZOOM

Zoom out to display the entire map.

VIEW > VIEW REPORTS

Generate a report for the selected map features.

STOP

Stop or interrupt the map display from updating and dynamic
map layers from downloading.

HELP > HELP CONTENTS

Open the online help to get information about viewing maps. If
you do not have the help installed on your computer, it will be
opened from the Autodesk MapGuide web site.
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Note: “Zoom Go To” is a very useful command. You can zoom to the following categories:
•

1:250,000 grid number

•

1:50,000 grid number

•

1:20,000 grid number

•

Place Name

•

Stream Name

•

Stream Alias Name

•

Watershed Code

•

Watershed Group (4 letter code)

•

Hatchery and Releases Sites

•

Example (zoom to the mouth of the Serpentine River):
1.

Select the Category “Stream Name”.

2.

Enter “Serpentine” for the location

3.

Enter the width of the map area that you want.

1. Select the “serpentine river” from the list and click OK.

VIEW FEATURES:
•

Once zoomed in below 1:200,000 scale, the mouse cursor will display BC watershed
codes and stream names as it is placed over the stream line.

•

At the 1:500,000 scale the habitat feature points appear. The mouse cursor provides
some information on the point but a more complete report can be viewed by invoking a
report (see next item for instructions).
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VIEW A REPORT:
•

Some features on the maps have reports attached to them (for example: the on- line data
entry layers and all the Fisheries and Habitats layers).

•

There are three ways to invoke the reports:
1) Double-click on the feature
2) Highlight the feature and click on the report button:
3) Right-click anywhere on the map and select View -> Reports

•

Once zoomed in below 1:200,000 scale, the rivers, lakes, wetlands etc are linked to the
Fisheries Data Warehouse. Note: you can turn on the layer called “Rivers with FISS
reports” under the “Hydrology” layer group. Those streams that have reports will display
a magenta line. Switch off the magenta line “Rivers with FISS reports” function after
you have reviewed or printed the selected reports.

1:20,000 FEATURES:
•

Once you are zoomed in to at least 1:50,000 scale, a number of useful map display
features become available. You can switch on 1:20k features such as contours,
streamlines, roads, and other layers. These additional layers are being obtained on-line
from another server at a different location in Vancouver, British Columbia.

•

The thin blue stream line that is visible on the base maps is the BC Watershed Atlas
stream line. In many cases this line does not accurately represent the stream course. It is,
however, the line that all the various reports are connected to. The 1:20k rivers lines
appear as thicker blue lines when you switch on this feature. Although there are some
inaccuracies, these lines depict the stream course more accurately. They cannot be
highlighted and no reports are attached to them. They can be used to more accurately pin
point your new data entry locations.
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VIEW ORTHOPHOTOS:
•

Once zoomed in you may also view orthophotos for selected areas and turn on and off
coastal features as an overlay.
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If you have a username and password you may also turn on the bathymetric information.

PRINTING MAPS:
•

Set up the map display as you wish by zooming, panning and turning layers on and off.

•

Right-click anywhere on the map and select “File -> Page Setup”. The page setup box
will appear and you can enter a title, print just the map frame, print both map frame and
legend frame etc. The printer setup tool should be used to make sure your paper size,
orientation, colour choices etc. are set properly.

•

Click on the Print Setup button and click OK on the next dialog box

•

You can by-pass the Page Set-up by right-clicking and selecting File -> Print

To learn how to use the ActiveX Control:
•

Right-click anywhere on the map

•

Select Help-> Contents
or

•

Click on the yellow Question Mark in the toolbar.
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INITIAL MENU:

Get a
password:

Fill- in the information and someone will contact you to give you a username and
password. Make sure that you have entered a valid e- mail address and phone
number to ensure a prompt response.

Login:

Enter your username and password to be able to add, update or delete data. No
password is required to browse the map and get a report on a specific feature on the
map.

Help:

Instructions specific to the Pacific Coastal Resources Atlas.

Metadata:

Listing of the layers available and the scale ranges at which they can be turned.
Short description of the data contained in the layer and its source(s).

Data Entry:

Brings up another set of customized options that will be described below.

THE “DATA ENTRY BUTTON:
Note that you must be logged on to have access to the data entry menu. Also, upon entering that
menu, you will see a message stating that you must enter the source of your data before
digitizing new features. Once the source is entered in the system, you can link any new features
to it (see data entry form).

Data entry menu:
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Click on the down arrow to view the list and select a feature type to
digitize.
Click on that button after you have selected a feature type and move the
mouse over the map area. You can now start digitizing your feature.
Double-click to end the digitizing and a data entry form will open. Enter
all the attributes information and click the submit button on the form.
This will bring up a form where you can enter the source of your data.
Once the source is in the system, you will be able to select it when you
will be entering the attributes of your digitized feature(s).
Go back to previous menu.
Allows you to change the attributes information of a feature that you have
previously digitized (not its geographic location). You must select the
feature on the map before pressing that button (see heading: “Update
Data”)
Allows you to delete a feature that you have previously digitized. You
must select the feature on the map before pressing that button (see
heading: “Delete Data”)
Refresh the layer(s) after a change (very important in order to see the
change made).
Allows you to view the area of a polygon in square kilometers, square
meters and acres. You must select a polygon before pressing this button.
To collapse the layers under each layer group.
To expand the layers under each layer group.

ENTERING A SOURCE IN THE PCRA DATABASE:
•

Login

•

Press the “Data Entry” button

•

Press the “Enter a Source” button

•

The following data entry form will appear:
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Make sure that you enter a meaningful name for the field “Source (short form)” as you
will be required to select your source based on that field when you digitize new data. For
example a source could be named: “Hay et al. 1989”. When you fill in the data for your
new features, you would select Hay et al. 1989 from the pick- list as below:
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DIGITIZE A FEATURE (login required):
•

Login

•

If the source of your data is not in the system yet, enter your source (see heading : “Enter
a Source” above).

•

Zoom in to a scale below 1:100,000 around the area of your choice

•

Press the “Data Entry” button

•

Select a Feature Type from the drop down menu

•

Press the “Map It” button, you are now in digitizing mode. A message with instructions
will pop up:

•

A data entry form similar to the one below will appear. Many of the fields in the form
have “pull-down” lists – please fill in all the fields as completely as possible.

•

Click “Submit” and your information will be included in the PCRA database.

•

Click the “Refresh layer” tab in the top right corner. The map will be re-drawn with your
new feature displayed.

•

To review the information you just entered, click on your new feature to highlight it and
then click on the view report button (or right click “view reports”, or double-click on it).
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EDIT A FEATURE (login required):
•

Change the attribute information about a feature (not its geographic location). Note that
you can ONLY make changes to the features that you have entered and nobody else can
change your data (except the Administrator).

•

Select the feature on the map (will be highlighted)

•

Click on “Update” button

•

The same fields as the Data Entry Form are available and the existing values can be
changed.

•

Submit

•

Refresh Layer

•

View report with updated values.

.

DELETE A FEATURE (login required):
•

Delete a feature and its attribute information. Note that you can ONLY delete features
that you have entered and nobody else can delete your data (except the Administrator).

•

IMPORTANT!!!! There is no UNDO command so use this function with caution.

•

Select the feature on the map (will be highlighted)

•

Click on “Delete” button

•

A confirmation message will let you know that the point has been deleted.

•

Refresh Layer

.

41

−

DRAFT – June 6, 2005
REFERENCES

Booth, J. and H. Rueggeberg. 1994. Consolidation of Fisheries Resource Information West Coast
of Vancouver Island. Barkley Sound and Alberni Inlet. Can. Tech. Rpt. Fish. Aquat. Sci.
No. 2002. 48 p + Appendices.
Booth, J., H. Rueggeberg and M. Wright. 1995. Consolidation of fisheries resource information
West coast of Vancouver Island Offshore. Can. Tech. Rpt. Fish. Aquat. Sci. No. 2102. 78
p + Appendices.
Harbo, R.M. 1997. Intertidal Clam Resources (Manila, littleneck, butter clam) Volume III: The
Northern Inside Waters of Vancouver Island and the British Columbia Mainland. Can.
MS Rpt. Fish. Aquat. Sci. 2418: vii + 79 p.
Harbo, R.M., K. Marcus and T. Boxwell. 1997a. Intertidal Clam Resources (Manila, littleneck,
butter clam) Volume I: The West Coast of Vancouver Island. Can. MS Rpt. Fish. Aquat.
Sci. 2416: viii + 116 p.
Harbo, R.M., K. Marcus and T. Boxwell. 1997b. Intertidal Clam Resources (Manila, littleneck,
butter clam) Volume II: The Southern Inside Waters of Vancouver Island and the British
Columbia Mainland. Can. MS Rpt. Fish. Aquat. Sci. 2417.
Hay, D.E. and P.B. McCarter. 2001. Herring Spawn Areas of British Columbia: A review,
geographic analysis and classification. Web page address:
http://www.pac.dfo-mpo.gc.ca/sci/herspawn/herspawn/default.htm
Hay, D.E., P.B. McCarter, R. Kronland and C. Roy. 1989. Spawning Areas of British Columbia
herring: A review, geographic analysis and classification. Volumes 1-6. Canadian MS
Rep. Fish. Aquat. Sci. 2019.
Lightly, M. 1996. Consolidation of Fisheries Resource Information West Coast of Vancouver
Island. Clayquot Sound and Long Beach. Can. Tech. Rpt. Fish. Aquat. Sci. No. 2121. 63
p + Appendices.
Lightly, M. and J. Hillaby. 1996. Consolidation of Fisheries Resource Information West Coast of
Vancouver Island. Southwest Vancouver Island (Race Rocks to Cape Beale). Can. Tech.
Rpt. Fish. Aquat. Sci. No. 2122. 48 p + Appendices.

42

−

DRAFT – June 6, 2005
APPENDIX A

Data layers included in the compilation of information of Fisheries Resource Information,
Herring Spawn Distribution

Layer File Name

hspawn_poly

hspawn_FO_poly

hspawn_pnt

hspawn_fo_shore

hspawn_shore

Description
Polygons of spawn mapped from maps created by Fishery officers
or from dive surveys for the years 1942-97. This data was collected
and digitized by Doug Hay’s group at PBS. Not all spawn records
were mapped. Accuracy varies depending on mapping method.
This data is meant to be displayed with the legend provided but not
queried. The more years a spawn has been mapped for an area the
deeper red-brown colour applied by the legend. There is one field
per year and a positive number for a field means that spawn was
mapped for that polygon in that year. The final field is the total
number of years that spawn was recorded for that field and is what
is linked to the legend.
Polygons of spawn mapped by DFO regional staff but maintained
separately from the data collated by Doug Hay’s group at PBS. This
represents the DFO regional staff’s opinion of the area covered by a
typical spawn. This was used to capture spawn that might have
been missed in the herring spawn database hspawn_poly.
DFO maintains a database of Spawn timing, frequency and intensity.
The data collection is ongoing and the current file is based on
information from the years 1928 to 2001. The DFO table provided
lat/long positions that represent the start point of a km segment of
shoreline. However these positions are inaccurate and were
therefore moved to match the TRIM shoreline with approx. 1 km
spacing.
DFO regional staff indicated the shorelines along which they had
observed spawn. Some of these locations were not recorded in the
above two data sets. A field gives the rough timing of the spawn in
that location and comments indicate if it was a one-time event or if it
was unconfirmed.
This file brings together all of the above herring data into attributes
of the TRIM shoreline. The point file “hspawn_pnt” was used to cut
the TRIM shoreline into segments with the attributes of the start
point. Additional segments were added if spawn was indicated from
any of the other sources and the attributes such as timing or
comments were added from those sources. This layer is coloured a
darker red-brown the greater the spawn index. The legend is based
on a coast wide gradient where shorelines with an index in the top
3rd coastwide are coloured the darkest. Areas with no index
assigned are give a rating similar to those with a low index.
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Locations of Significant Concentrations of Fish/Invertebrates
based on information provided by DFO regional staff

Layer File Name
Eulachon_Holding
Juvenile_Fish

Significant_Species
_Concentrations

Description
Areas where eulachon adults hold before spawning
Areas where concentrations of juvenile fish (herring, salmon,
rockfish or eulachon) have been recorded.
Significant concentrations of specific invertebrate species
including (but not limited to):
§
§
§
§
§
§

Areas where squid concentrate for spawning
Areas where jellyfish concentrations have been observed
Beaches which have large seed populations of clam s but which are not harvested
Urchin barrens
Areas where sponge bioherms have been observed
Sandlance concentrations
Areas where capelin spawn

§
Salmon_Holding
Areas where salmon hold before migrating up river
Salmon_Migration_Route Salmon migration routes as line segments
Herring_Holding
Areas where herring concentrate prior to spawning.
Locations of Fisheries - based on information provided by DFO regional staff

Unless otherwise stated areas are for rated for commercial and recreational fisheries

Layer File Name

Description

Clam_Beds

Locations of clam beds (and use level where recorded)
Areas where crabs are harvested (Dungeness, Red Rock,
Crab_Fishery
Tanner, Box)
Seacucumber_Fishery Areas where sea cucumbers are harvested by divers
Geoduck_Fishery
Areas where geoducks and horse clams are harvested by divers
Octopus_Fishery
Areas where octopus are harvested by divers or hand
Prawn_Trap_Fishery
Areas where prawn trap fishery takes place
Shrimp_Trawl_Fishery Areas where shrimp trawl fishery takes place
Urchin_Fishery
Areas where urchins are harvested by divers
Areas where misc. species (abalone, mussels, gooseneck
Misc_Fishery
barnacles, chiton, welks…) are harvested.
Herring_ROK_Fishery Locations of herring Roe-on-kelp impoundments
Herring_Fishery
Areas where Herring food, bait or spawn fishery takes place
Salmon_Troll
Areas where commercial salmon troll fishery takes place
Salmon_Net
Areas where commercial salmon gillnet/seine fisheries take place
Areas where commercial groundfish hook & line fishing takes
Groundfish_Hook_Line
place
Groundfish_Trawl
Areas where commercial groundfish trawl fishing takes place
Tuna_Fishery
Areas where commercial tuna troll fishery takes place
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Sport Fishing (finfish) and Diving - based on information provided by DFO regional staff
Layer File Name
Sport_fishery

RecDive

Description
Hot spots for Sport fishing (species noted); note that information
from the Strait of Georgia aerial based surveys of summer sport
fishing has been included in this data layer.
Recreational dive sites (currently only DFO statistical area 12)

Habitat features - based on information provided by DFO regional staff
Layer File Name
Kelp
Eelgrass
Special_Shorelines

Description
Kelp beds identified by DFO staff and not currently in other kelp
inventories.
Eelgrass beds identified by DFO staff and not currently in other
eelgrass inventories.
Shoreline segments identified as being special (salt marshes,
tidal flats, highly productive estuaries)

Marine Mammals - based on information provided by DFO regional staff
Layer File Name
Seals
Sealions
SeaOtters
Humpback
Gray
Orcas_resident
PWSD

Description
Points representing the locations of haulouts and rafting areas
recorded during seal surveys.
Points representing the locations of haulouts and rafting areas
recorded during sea lion surveys.
Areas of distribution, relative abundance

Areas of concentration and/or high use as identified by DFO
regional staff or marine mammal experts. For Humpback
whales, Gary whales, resident race of Killer whales, Pacific
whitesided dolphins, Dall’s porpoise and Harbour porpoise

Dalls_P
HarbourP
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Fishery Distributions Based on Catch Data
Currently only available for DFO Statistical Area 12 (NE Vancouver Island)

Layer File Name

Description

Crab_catch

This data is displayed as polygons based on DFO statistical subareas classified on the basis of the total landings in that sub-area
from 1994-98. The catch data are displayed and normalized by the
Geoduck_catch
area of the sub-area that is within the depth range for that fishery
Grurchin_catch
and expressed as lbs/hectare. Dive fishery catch data (sea
Redurchin_catch cucumbers, geoducks, red urchins, green urchins, and octopus) are
limited to portions of the sub -area with depths <20m; Crab trap
Octopus_catch
fishery catch data are limited to portions of the sub-area with
depths <50m and rockfish and prawn fishery data are limited to
Prawn_catch
portions of the sub-area with depths <100 m. The landings for the
Shrimp_catch
shrimp trawl fishery are applied to all depths.
Rockfish_catch
Cukes_catch
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